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[bookmark: _Toc294982606]Purpose
You will learn how to use the Timelapse Image Analyzer software to analyse a series of timelapse photographs taken from a field-mounted camera.
Note. What you see when you run the Timelapse program may not exactly match the screen images in this manual, due to updates made in the program after the screen images were taken. These are mostly minor. 
[bookmark: _Toc294982607]
To Begin
You should have: 
an image folder containing a series of timelapse images taken by the field-mounted camera,
a CodeTemlate.xml file specific to your image collection, which must be placed in the image folder. It will be given to you by the biologist managing your project. 
Definition. The CodeTemlate.xml file defines all the fields – the codes – that will appear in the software. Codes are the things you fill in, such as counts, comments, and choice selections. The codes along with the data you enter are used to create a file that you can open with Excel as a spreadsheet. These codes are specific to your profession, which is why they are created by your biologist in charge. 

[bookmark: _Toc294982608]After You are Done
When you are done your analysis, you will end up with two new files in your image folder.
ImageData.XML contains all the data that you entered. It is used internally by the program. Don’t remove it, unless you want to delete all your data!
ImageData.CSV is a text file that can be read by almost all spreadsheet packages, such as Excel. It is in comma separated values format. 
Your biologist in charge will likely ask you to send both these files to him or her. 
Important. The ImageData.CSV  file is updated whenever you use the timelapse image software. Thus if you change anything in the ImageData.CSV file (e.g., using Excel), those changes will be lost. 



[bookmark: _Toc294982609][bookmark: OLE_LINK1][bookmark: OLE_LINK2]Getting Ready
You will need to do several things to get ready: have a Windows computer with a reasonable screen, download the software, and download (or get from your managing biologist) an image set (including the CodeTemplate.xml)
[bookmark: _Toc294982610]Your Computer

Windows. The software runs within Windows (it has been tested on Windows 7, Windows Vista, and Windows XP with the latest service pack update), but should also run on a Mac if you are using a Windows emulator 
Technical Note. Timelapse requires Microsoft’s .Net framework 3.5, Service Pack 1, which is likely already installed on your computer if you’ve kept up with Microsoft updates.

However, if you find Timelapse ‘crashing’ unexpectedly, it is likely because the correct .Net framework isn’t installed. The Timelapse website (see next page) gives links that will let you install the .Net framework (just involves a few button presses – no technical knowledge needed). However, if your machine is managed by an IT person, ask them if it has the above, and if not, have them install it.
Large, high resolution screen. Whether or not you use our software, you will be looking at images for (in some cases) very small things. In our experience, the larger your screen and the better its resolution, the easier and more accurate it will be for you to spot things in the images. Note that a projector or basic laptop may work for you, but many are actually low resolution (e.g., 1024 x 768). Small laptops can be a problem because of their small screens.
[bookmark: _Toc294982611]Download the software
This should be very straight-forward if you’ve installed software before.
Note. There are two methods for downloading software. Choose the one that suits your situation

1.  	Installing on your own personal computer: uses an automated installer. Definitely the better ways, as the application appears on your start menu, and  the software automatically checks for updates

2.  	Installing on an institutional computer, where you download a zip file and manually install the software into a location of your choosing. You will also have to check for updates yourself.

The reason there are two methods is that institutional computers normally ‘lock down’ your computer for security reasons, where it won’t let you install software using an automated installer. So you have to do it manually. Drats.



[bookmark: _Toc294982612]For both:
1. Go to http://grouplab.cpsc.ucalgary.ca/cookbook/index.php/Demos/TimelapseCoder. 
You should see something like this.
[image: ]

Scroll to the section marked Download, Installation and Use. You should see something like this. 
[image: C:\Users\Saul\AppData\Local\Temp\SNAGHTML1e2bb1.PNG]

[bookmark: _Toc294982613]

If you are installing on your own personal computer

Select the 1st Timelapse Image Analyzer link. Your browser will download a file called setup.exe. Open that file, and follow the instructions in the dialog box, after which your program will be installed.

You can now start the program by selecting Timelapse Image Analyzer  from the Start Menu, (but hold off for now until you have your image set ready). It may be on the top of your Start Menu (left figure), but it should always be there in a folder under  Grouplab  /  Timelapse (right figure). 
[image: C:\Users\saul\AppData\Local\Temp\SNAGHTML11e74c3.PNG]          [image: C:\Users\saul\AppData\Local\Temp\SNAGHTML12723e8.PNG]
If you want to delete the program, open up your Control Panel  and select the Uninstall or change a program setting. You will find it in the list, where you can uninstall as with other applications.
The program requires the Microsoft .Net Framework . If you have an up-to-date version of windows (especially Windows 7), this should already be there. The installer will also likely install it for you if its missing. But if the program complains or says it is missing, or doesn’t run at all, try installing it (the link to it is on the download page above, and it doesn’t require technical expertise to install it).
Updating the software. When installed this way, the Timelapse program will automatically check to see if there is a new version available whenever you start it. If there is, it will ask you if you want to download the new version. You probably should.
[bookmark: _Toc294982614]



If you are installing on an institutional computer

3. Select the 2nd Timelapse Image Analyzer link. Your browser will download a zip file.

4. Open the zip file, and drag the Timelapse application out to a place of your choosing, e.g., your Desktop, or your My Documents folder.

5. You can now delete the zip file.

6. You can now start the program by opening (double-clicking) the Timelapse.exe program   from wherever you put it (but hold off for now until you have your image set ready). 

7. If you want to delete the program, just delete the Timelapse.exe file.

8. The program requires the Microsoft .Net Framework . If you have an up-to-date version of windows (especially Windows 7), this should already be there. But if the program complains or says it is missing, or if it crashes unexpectedly, or if it doesn’t run at all, ask your systems person to install .NET Framework 3.5, including its Service Pack 1 (the link to it is on the download page above).

Updating the software. When installed this way, you will have to check the web site every now and then to see if a new version is available. If there is, delete the program and repeat the above steps to get the new version.



[bookmark: _Toc294982615]Downloading the Sample Image Set
For the purpose of following this tutorial, use the training set of images available on the download page. Your managing biologist or colleague will likely be the person giving you the image files and/or the CodeTemplate.xml file for you to do actually do your work. 
This training set contains two folders, each containing timelapse photos.  One image set is of a lake taken during the summer time, the other is from a different lake taken during the winter.  We will use the winter set.
1. Again, go to http://grouplab.cpsc.ucalgary.ca/cookbook/index.php/Demos/TimelapseCoder. 

2. In the Tutorial Manual section, go to the section Sample Image Sets. Following the same method as you used above, use the link Tutorial Image Set to save the zip file, and uncompress it.

3. You should now have a folder titled Tutorial Image Set, which in turn contains two folders.
· Alleyne Winter
· Kentucky Summer	 

4. Notice that both sub-folders have a file called CodeTemplate.xml. 
[image: ]
Important Note. These image folders are somewhat typical of most image sets that you will be processing.
· They contain a series of timelapse images taken by the field-mounted camera. 
· They contain a CodeTemlate.xml file. If you don’t have one, ask your managing biologist for it. The software will not work without this file!
· The software uses the names of the image files to determine the sequence. This is not normally an issue, as most cameras name images by some common text at the beginning, and then adding a number (padded with leading 0’s) at the end.
         imageName0001.JPG, imageName0002.JPG, …
         imageName (00912).JPG, imageName (00913).JPG…..
· A potential problem can happen if the numbering does not contain leading 0’s. For example, files ending in 1, 2,… 10, 11 are actually ordered 1, 10, 11, 2… which is not what you want.  Leading 0s avoid this, i.e., the files should end in 0001, 0002… 0010 
· If it is a problem, you can use the renumbering software available on the download page, which will automatically renumber the images correctly.

[bookmark: _Toc294982616]About the Sample Image Set and CodeTemplate.xml file
These images were obtained from Freshwater Fisheries Society, BC. Their cameras are set to take images every hour, 24 hours a day. Thus they contain both day and night time shots. Normally, hundreds or more images may be in a single folder, but for our training purposes we’ve only included a small number of them. We’ve also ‘corrupted’ a few images (where they are not readable as images) just to show you what the system will do with that.
[image: ]
Freshwater Fisheries Society, BC uses these images to calculate fishing effort, that is, the amount of fishing load on a lake. To do this, they count the number of anglers fishing from the shore line, from boats (including ‘belly boats’), and (in winter) on the ice. They also need to collect other information about each image. 
The actual ‘codes’, or fields of interest, were developed  by the Freshwater Fisheries staff, which in turn were used by them to create the CodeTemplate.xml file. As we will see, their codes include counts of anglers in boats, anglers on the shore, anglers on ice (in winter), and other factors like how visible the lake is in each image. 


[bookmark: _Toc294982617]Analyzing Images
[bookmark: _Toc294982618]Loading your image set
The first time you load your image set, Timelapse will open each image and do some pre-processing of it. This happens only once (assuming that you save your work!). You will see each image displayed briefly on the screen as this happens. If you have a huge number of images, this could take several minutes, so you may want to have a cup of coffee ready. Because our sample image set is small , this should only take a few moments.
1. Start the software by selecting Timelapse Image Analyzer from your start menu (look in the Grouplab menu item if you can’t find it). You should then see something like this. This opening screen contains some documentation that serves as a reminder of how to use this system. You can revisit this documentation at any time by selecting from the Help menu.
[image: C:\Users\Saul\AppData\Local\Temp\SNAGHTML6f9722.PNG]

2. Expand the window to the full size of your screen. This is a suggestion. The larger the window, the bigger and better your monitor, the easier it will be to see details in each image.  




3. Load the images. Select Load images from folder… from the File menu and navigate and select the folder containing your images from the dialog box. For this tutorial, load the Alleyne Winter folder.
[image: ]

4. Watch the software pre-process the images. As mentioned, you will see the system go through each image in turn. After it is done, it will display a dialog box showing a summary of what it has found. In this case, we see that out of the total of 84 images, it found 2 that were corrupted and therefore unreadable, 46 that were quite dark and likely night-time shots, and 36 that are ‘valid’ daytime shots. 
[image: ]

5. [bookmark: OLE_LINK3]The software may ask you to verify the date format. Some cameras store their dates in day/month order, while others store it in month/day order. Timelapse tries to determine which this, but sometimes it can’t. When that happens, it will raise a dialog box showing you two possibilities of a date for a particular image, and asks you to tell you which is the correct one. However, you won’t see it in this example image set as it figured it out.
[image: C:\Users\Saul\AppData\Local\Temp\SNAGHTMLa73bab.PNG]

6. See what the software automatically filled in for you by looking at the top row. We’ve annotated each item below to explain it. 
[image: ]
Note. The software reads meta-data embedded in each image to get its date and time. If that isn’t there (meta-data is camera-specific), then it uses the file modified time. Give a quick check to make sure that the date and time matches up. If it does for a few images, then it should be fine for all of them except, perhaps, for those images that are corrupted.


7. Save the file and preview the spreadsheet. From the File menu, select Save and Preview. If you have Excel installed, something like the following appear. Notice that it contains various headers (top row) and that it has populated the cells with the data that the software has already pre-processed. 
[image: ]
Important. Do not modify the Excel file. Close it after reviewing it. The Timelapse image analyzer generates the spreadsheet file every time you save your work. That is, it’s a one-way process. If you modify the Excel file, it will not update the fields you see in the Timelapse Analyzer. The only time you should modify the Excel file (if you have to do this at all) is after you are completely done your analysis with the Timelapse tool.

8. You will see two files are added to your image folder (look in the Alleyne Winter folder)
a. ImageData.xml  is a file created and used by the timelapse software to store all your saved data. If you quit the program and restart, it will open this file so you can continue where you left off.
b. ImageData.csv is a spreadsheet file generated for you to use. It is in .csv, or comma separated values  format, so any spreadsheet should be able to read it. As mentioned above, it is re-created and over-written every time you save your work with the analyzer
[bookmark: _Toc294982619]

Timelapse Interface Basics
Before showing you how to analyze your images, let’s review a few basic things about the Timelapse interface, just so we won’t have to explain it later. Have Timelapse running and displaying images so that you can try some of these features out.
Navigating through images. You can do this by one of two ways. 
· The left/right arrow keys on the keyboard lets you move back and forth through your images in a sequence. You  will normally use these a lot to navigate through your image set.

· The trackbar lets you scroll through your image set simply by sliding it back and forth. This is useful for making larger jumps through your images, or to go to a particular image.[image: ]

The Status bar on the bottom right indicates the image number and the total number of images in the current image set. This total number will be affected by the view filter that you can select from the View menu, which we will describe shortly. Other information will be displayed there that reflects what you are doing.
[image: ]

The fields. The rows at the top contain three types of fields: Notes, Counters and Fixed Choices.
[image: C:\Users\saul\AppData\Local\Temp\SNAGHTML24ca84.PNG]
· Notes are fields where you can enter some text by typing. An example is the Comments field above. Notes that are filled in by the system during pre-processing cannot be edited and are shown greyed-out (e.g., the File field above).
[image: ]

· Counters are fields used to count things. For example, B5  (which represents ‘boats with 5 anglers in it’) currently has 0 counts. The label is actually a button – when you toggle it on, every click on the image will be increase the count – we will explain this later. You can also type a number directly into the count, although this is a less preferred way of doing it for reasons we will explain shortly.
[image: ]
· [image: ]Fixed Choices are fields that you fill in by selecting from a pull-down menu (i.e., by clicking the down-arrow at its right). For example, %Visibility has a menu showing various percentage values that you can select from.










[image: ]
Tooltips give additional detail about each field. You can see what each field in the top row means by hovering your mouse over it – this raises a tooltip. In the example below, hovering over the counter button B4 explains that this B4 represents the “# of boats with 4 anglers”.
	 




[image: C:\Users\Saul\AppData\Local\Temp\SNAGHTMLa98642.PNG]Context menus are included with both the fixed choice and the notes fields. Their items let you ‘copy down’ values from this field to other images, or values from previous fields to here. We will describe how these work in a later section. 

The magnifying glass appears as you move your mouse over the image. You can control it by several means. Try it!
· Controlling the magnifying glass
M – typing the letter M while your mouse is over the image will toggle the magnifying glass on  
        and off.  You can also choose Magnifier from the View menu to do the same thing.
U –  will increase the magnification (make it go Up)
D –  will decrease the magnification (make it go Down)

The images below show the magnifying glass set at two different magnification levels. Normally, you will set the magnification to something that makes sense for your image set, and likely leave it there. 

[image: C:\Users\saul\AppData\Local\Temp\SNAGHTML2e89e1.PNG] [image: C:\Users\saul\AppData\Local\Temp\SNAGHTML308246.PNG]
Zooming and Panning. 
· Zoom in and out of the image by using  the scroll wheel on your mouse. For example, compare the zoomed in left image below (with the magnifying glass) to the image above.
· Pan across the zoomed image by clicking and dragging across the image. That is, hold the left button down and move the cursor. For example, the person is panning across the shoreline in the right image to see if they can see other anglers. 
[image: C:\Users\saul\AppData\Local\Temp\SNAGHTML347070.PNG] [image: C:\Users\saul\AppData\Local\Temp\SNAGHTML3aa1c4.PNG]



The Menus
There are several pull down menus. While the meaning of most items should be self evident, here is a summary.[image: C:\Users\saul\AppData\Local\Temp\SNAGHTML51de21.PNG]
File menu
· Load images from folders lets you specify the folder location of the image set you want to analyze.  
· Save and Preview will save your work, while at the same time raising an Excel spreadsheet (assuming you have Excel installed) that shows your progress so far.
· Save is as above, except it will not show you the Excel spreadsheet.
· Export this image lets you save a copy of the current image to some other place. The original is kept intact.
Note. There is currently no Undo option in the Timelapse tool. We recommend you save your work every now and then, so if things go horribly wrong you won’t have to start from scratch.
View menu lets you set filters that selectively show only some of the images from your image set.
· All images displays every single image. If an image file is corrupted, a substitute image labelled ‘corrupted’ is displayed in its place.  
· Dark images displays only those images that are very dark , i.e., night-time pictures. This is typically used for you to review and code night time images in a single batch.  
· Corrupted images displays only those images that are corrupted, i.e., that the program couldn’t read.  Again, this is typically used for you to review and code these corrupted images as a single batch.  
· All but dark and corrupted displays the remaining non-dark, non-corrupted images. These images will likely be the ones that demand most of your attention.
Options menu lets you adjust a few settings on the fly.
· See / Edit Notes for this Image Set allows you to edit and save notes that are associated with this image set, e.g., comments as a whole, your own ‘to do’ list, or any text 
· Magnifier turns the magnifying glass on and off. You can use the keyboard shortcut ‘M’ to the same effect.   
· Audio feedback turns audio on and off. Currently, audio is used to give you feedback of the counts you make while counting (more on counting  later).
· Auotsave every few  minutes is on by default. Essentially, it means that Timelapse will save all your work every few minutes, as if you selected ‘Save’ from the File menu. You can turn this off if you want. 
· Date: Swap Day and Month will swap the Day value with the Month value in the Date box across all images. For example, if the Date is 03/09/2011 (Sept 9, 2011), it will change it to 09/03/2011 (Mar 3, 2011). This option is included because some cameras  store dates in day/time order, and others in time/day order. While the software tries to figure this out when it first reads in the images, this gives you the chance to change the order if it got it wrong.
· Date: Add Correction Value will let you adjust the date if your field camera was not initialized to the correct date/time. All you have to do is supply the correct date/time for the first image, and all others image dates/times will be adjusted accordingly.
· Date: Correct for Standard / Daylight Savings Time will let you adjust the date to account for the extra / lost hour during time changes. It will ask you to navigate to the first image on that date, and will then ask you to either add or subtract an hour and whether that correction should be applied to the earlier or later images. Sounds harder than it is 

Statistics menu
· Image Counts displays the Total Counts of Images dialog box – the one you saw after the pre-processing was completed .
Help menu
· Brief Overview displays the brief instructions you saw when you first started the. 
· The Timelapse Web Page will display the main Timelapse Image Analyzer web page in your browser.
· The Timelapse Manual will display the Timelapse Tutorial Manual (a PDF file) in your browser. Note: This is a large file, so it may take some time to load. You need to be connected to the internet.
· Download Sample Tutorial Images will try to download the sample images that accompany the Timelapse Tutorial Manual. You can use these images to practice on as you follow the manual’s instructions. You need to be connected to the internet.
· Timelapse Mailing List – Join it will let you join this mailing list, which will keep you informed of updates and occasional news. Mailings are fairly infrequent.
· Timelapse Mailing List – Send Email will let you send email to that mailing list.
· About gives information about the software (such as its version number) as well as contact information if you have any problems and want to contact its creator Saul Greenberg.  
Toolbars contain the fields. Each toolbar tries to fit all fields in a row. If it can’t fit, it puts them in a menu  that you can raise with the arrow on its far right. This won’t normally be a problem if your window is expanded to fit the entire screen, but it will happen if you keep your window small. For example:
[image: ]

You can also move the toolbar around by dragging its right edge, for example by moving it to the empty space on the right of another toolbar. 
[image: ]
Markers appear on the image after you select a counter.
· Create a marker by left clicking atop the thing you want to count on the image. Note that you must have a counter selected 
· Delete a marker by right clicking on it.
Take a look at the image below. The S/I counter (# Shore/Ice anglers)  is selected, and the biologist has clicked on the two ice fishermen. Markers associated with the currently selected counter appear in yellow. Hovering over a marker raises a tooltip that describes it. The biologist had previously selected another person on shore under the  S/I Ukn counter; that one appears in red as it is associated with another counter.  
[image: C:\Users\saul\AppData\Local\Temp\SNAGHTML66ce1d.PNG]When you hover over any counter, the marks associated with that counter will ‘glow’, helping you to see which markers are associated with that counter. Of course, you  can just click on that counter, which will change its markers color to yellow (and the other ones’ red). 

Backups of your work
Just in case things go disastrously wrong during an editing session, Timelapse will make an exact copy of your data files when you first start it up. Specifically, the ImageData.cvs and ImageData.xml file are copied into two backup files called ImageData.BACKUP.cvs, and ImageData.BACKUP.xml in your image data folder.
If by chance you want to go back to those backed up versions:
· move the latest ImageData.cvs and ImageData.xml files somewhere else (or delete them if you really don’t need them). 
· edit the backup filename to remove the ‘.BACKUP’ portion.  
When you next open timelapse, it will use the backup data files.

[bookmark: _Toc294982620]The Timelapse Workflow
Timelapse supports a certain workflow, or sequence of events, that you are likely to follow when analysing your images. The basic steps are:
1. Populate the fields that are common to all images
2. Manage Dark and Corrupt images
3. Analyze your remaining images
We will discuss each in turn.

[bookmark: _Toc294982621]Populate the fields common to all images
Some of the fields associated with each image may contain a value that is identical across all images. In our tutorial set, for example, WBodyId  (or ID of the Water Body)  is the same, as all photos are of the same lake. As well, the sampler (you) will be the only one analyzing this image set. 
You could, of course, enter the WBodyId and your name for every image, but this is tedious indeed. Fortunately, the Timelapse tool lets you propagate a value to all images. Let’s use the Sampler field as an example. 
1. Type in your name. 
2. Right click on the label or the text field to raise the context menu.
Note. The Fixed Choice item has a bug: you have to click on the label – not the text box - to raise the context menu. This will be fixed in the future. 
3. Select Copy current value to all images. A dialog box will ask you to confirm this action. After you accept, all images will have its Sampler set to whatever you typed into it.
[image: ]
4. Test it. Navigate to any other image. You should see that they all contain the same value for the Sampler. 

5. Do the same for several other fields.
a. Set WBodyID to (say) Lake 357
b. Set Camera Type to (say) Moultrie
c. Set Lake Condition to Ice-covered – but only do this after verifying (by a quick scroll using the track bar) that the lake is indeed ice-covered in all images.

6. Save and preview, again as a test. The spreadsheet should show all these columns filled in with the same value.

Note. Afterwards, you can still change the values in these field if you see exceptions. However, you will have to do this image by image.

[bookmark: _Toc294982622]Manage Dark and Corrupt images
If your image set has many night-time shots, you probably want to deal with them in a uniform way. The same thing goes for corrupted images (hopefully, your camera won’t have any of them). We will use view Filters to do this. 
A view filter lets you look at a subset of all your images. You can choose a view filter by selecting one from the View menu, which corresponds to how the tool populated the Image quality field.
· All images: every image in the image set
· Dark images: those images classified as ‘dark’ (or night time shots) by the software
· Corrupted images: images that could not be opened
· All but Dark and Corrupted Images:  these are your ok daytime shots. Normally, these will be the ones that you examine for things to count.
Now let’s use these view filters to manage the dark night-time images.
1. Choose Dark images from the View menu. 
[image: ]

2. The first dark image will be displayed. You will also see that the image number / image count at the bottom left says that this is the 1st image of the 46 dark images. [image: ]

3. Check that all images are, indeed, dark. This should be the case, but it never hurts to check. Quickly scroll through them to verify this using the trackbar.

4. Change any fields that are applicable to only the dark images. For these dark images, we will set the    % Visibility to 0 for all of them in one operation. Here’s how.

a. Use the % Visibility’s pull down menu to set its value to 0% 

b. Right click on the % Visibility label (not the text field!) to raise the context menu below
[image: C:\Users\Saul\AppData\Local\Temp\SNAGHTMLb2f8f1.PNG]
c. Select Copy current value to this filtered view set of images. A dialog box will ask you to confirm this. The result of this action is that all dark images will now have its % Visibility set to 0%. Other images will not be affected. 

d. Do the same for the Comments field, where you add the text ‘Night image’. 

e. Test it, either by navigating the dark images, or previewing the spreadsheet, or changing the filter back to All images and navigating through them. You should see that only the dark images will have these changed values.



Now do something similar for the two corrupted images.
1. Choose Corrupted images from the View menu.

2. Because the image could not be opened, the timelapse tools inserts its own image in its place.
[image: ]
3. [bookmark: OLE_LINK4]Add a comment to the Comments box, for example ‘Image cannot be opened’.  

4. Select Copy current value to this filtered view set of images, as before.

5. If you select Save and Preview, your spreadsheet will now look something like this. 
[image: ]

6. At this point, many of the basic fields are now done. You are ready to start looking at the actual Ok images.


[bookmark: _Toc294982623]Analyze your remaining images

This ‘final’ step is actually where you do most of your work, as you will be visually scanning these images for things to count.
Set your filter to All but Dark and Corrupted Images; this will bring you to the first image. We will go through each image in turn, where we will emphasise an efficient way to analyze these images with the timelapse tool. Start at image 1. Along the way, we will introduce you to some additional features available in the tool.
[bookmark: OLE_LINK5]The  typical ‘workflow’ per image, explained shortly but included here as a summary.
1. Copy values set from early images. We will explain this shortly.  
2. Set any other notes and fixed choice fields to match what you see in this image.  
3. Scan the image for anglers (or whatever entities you want to count). Sometimes this may be hard to see, perhaps because the light is bad, or the things you are counting are really far away and thus very small. 
Typical strategies include:
a. Look at common places you expect those entities to be. 
b. Rapidly switch between this and surrounding images by using the left/right arrow keys. Your eye will be drawn to things that change between them.
c. Use the magnifying glass to see details in high-probability places.
d. Magnify  possible entities to scrutinize them, e.g., of you see something – a dot, whatever – use the magnifying glass to see details
e. Combine steps b and d: if you see something in the magnifying glass but are unsure if its actually something of interest, try using the left/right arrow keys to see if it’s the same across images, or if its no longer there (and thus likely something of interest). 
f. Use the image enhancers via the up / down arrow keys (we will explain this shortly)
4. Select the counter type, and click on each entity of that type.  A red circle appears where you clicked, and the counter will be incremented. If you left-click, it removes the circle and decrements the count. 
We will now illustrate this workflow across various images. The actual values we fill in are, of course, just for the sake of this example.
Image 1. 
1. Set any notes and fixed choice fields. For this image: 
· Set % Visibility to 100%, as we can clearly see the entire lake.  
· Add the comment ‘A nice day’.

2. Scan the image for anglers. In this particular image set we would do the following. 
· Look at common places you expect those entities to be. In this winter lake scene, you would concentrate on the ice-covered lake, the shoreline and (because you know that people often fish there) the open area on the far shore. For the summer photos, you would normally look at the shoreline, a dock (if any), the lake for boats, etc.
· Rapidly switch between this and surrounding images by using the left/right arrow keys. You won’t be able to go left, as you are on the first image. If you switch between this and the next image, you’ll see lighting differences but nothing really pops out, leading you to suspect that there are no anglers in the scene. 
· Use the magnifying glass and/or Pan and Zoom to see details in high-probability places.
To double check for anglers on the shore, you could quickly sweep the magnifying glass over the entire shore line, or zoom into an area of the shoreline and then pan across it.
· Magnify and/or zoom possible entities to scrutinize them. In this image, there is a dark dot in the far shoreline. Moving the cursor (and magnifying glass) over it reveals something is there. It looks like a boulder, but it is somewhat hard to tell at this point. While you could increase the magnification (the U key), the actual image resolution and quality – not its magnification – limits the detail we can see. Alternately, you can use the scroll wheel to zoom into the image.
[image: ]
· Combine steps b and d. By rapidly switching between images, you see (in this case) that the object hasn’t moved. Thus it is highly likely this object is just part of the landscape (e.g., a boulder?) and shouldn’t be counted. 
[image: ]
At this point, we are fairly satisfied that there is nothing in image 1, so we are ready to move to the next image.
Image2 
Introducing the  Copy Previous Values Button. Repeat the above process; like the first image, there are no anglers in this image that we could find. However, the earlier comment (It’s a nice day) and %Visibility of 100% still apply, but these are not filled in. We could fill it in by retyping and reselecting, but this will become tedious to do across lots of images.
[image: ]

Instead, you can press the Copy Previous Values button on the right. This copies the contents of all the yellow fields in the previous image to the fields in this image.  
[image: ]
The Copy Previous Values button is there because - most of the time - there is very little difference between one image and the next in a sequence. It’s reasonable for you to press this button on almost every image. If there is something that you want to be different, you can always change that. For example, if everything but the %Visibility was identical between images, you can press the button, and then change the %Visibility to the value you really want to apply to this image. 
Keyboard shortcut:  The C key will also activate Copy Previous Values.

Images 3,4,5
Introducing the  Propagate the last non-empty value to here… menu item.  Images 3, 4 and 5 also have no visible anglers on it (but feel free to check!). This time, time don’t press the Copy Previous Values button as you navigate through them. This means that the Comments and % Visibility fields will stay empty. 
On image 5, right click on the Comments field to raise the context menu, and select the Propagate the last non-empty value to here menu item.  A dialog box will appear that asks you if it should Copy ‘A nice day’ across the last 3 images seen in this filtered view? Say yes, and then navigate back through images 3-5. You will see that the previously empty Comments fields have now been filled in for all images in the filtered view set. Do the same with the % Visibility, by right-clicking the label.
[image: C:\Users\Saul\AppData\Local\Temp\SNAGHTMLbb97fe.PNG]
The basic idea of this Propagate feature is that you can fill in values of one image, but then just navigate other images until you see something different. At that point you can backfill the empty slots.  

In practice, you may use a combination of all these menu items along with the Copy Previous Value button to fill out these fields efficiently. 
	 
Introducing the Propagate the current value from here to the end… menu item.  
While we won’t show it in detail in this tutorial, another option on the context menu lets you copy the current value of a notes or fixed choice field to all images after this one in this filtered set. Note that it will overwrite any values already set! 
This is useful in cases where (for example) you may have copied a value to all images, but then realized that conditions have changed. For example, you may have set the lake conditions to ice-covered for all images, but then may have found that the ice has thawed on a certain date. You could set the value of the filed to Open, and then propagate that value forward.


Image 6
Introducing How to Count entities. In this image, 2 very small anglers appear in the far shore (check with the magnifying glass). You want to count these as S/I (# Shore/Ice anglers). While you could just type in a ‘2’ into that text box, a far better way is to use the counter. 

a. Click the S/I toggle button. It will stay highlit, showing that it is the currently active counter.[image: ]

b. Click on the two anglers. A mark ( a yellow circle) will appear over each angler, and the count in the S/I counter will increase automatically to 2.
[image: C:\Users\saul\AppData\Local\Temp\SNAGHTML78e3a1.PNG]
c. If you make a mistake, right click on the mark to remove it. The mark will disappear, and the counter will decrease by 1.
d. Don’t forget to select ‘Copy Previous Values’, as all other things are unchanged!

Marks are persistent. If you quit and reopen this image set, or go to another image and  then return to this one, the marks will still be there. This means you can check (and change) your counts at any time, or that another person can look at what you counted as a double-check. 
Image 7 has 1 angler on it that we could spot. Mark it.
Image 8 has 2 anglers on it. Can you see them?
Introducing the image enhancers via the up / down arrow keys to check images.
There are 3 image enhancers, as described below. These may help you see things in the image that may otherwise be hard to spot.

1. The next differenced image. If you hit the up arrow key once, you will see something like the image below. Just above the cursor are two white dots (1st image), which may attract your attention. If we move the magnifying glass over them, we see they are anglers. 
This image was created by comparing the current image with the next image, and highlighting everything that differs between them. This include differences due to lighting, shadows, slight movements of the camera, and – yes – anglers who appear in a location in one image but not the next one. The status bar on the bottom of the screen will also tell you that you are viewing the Next differenced image.
[image: ]
[image: ]
2. The previous differenced image will be seen if you hit the up-arrow again. It is similar to the above differencing method, except that it compares the current and the previous image. Hitting the up arrow key a 3rd time will bring you back to the normal image.

3. The surrounding differences is also similar, except that it visually compares the current image with both the previous and next image. 
Note. The next and previous differences create a composite of the difference between the current image and the next (or previous) one. This means that if an angler appears in 1 image, and that angler moves to a different position in the next image, you will likely see 2 anglers in the differenced image. That is, it’s a union of the differences. You would then use the magnifying glass to check which of those actually appears in the current image. 

In contrast,  the surrounding differences will only show those things that appears in the current image and that does not appear in either of the surrounding images. Thus if you see something there, it is likely in the current image. You should still check with the magnifying glass.

If you don’t know what I’m talking about, don’t worry. Let the visuals attract your attention, and then use the magnifying glass – or flip back to the normal image – to check what is there. 
Save and preview. You should now have your spreadsheet filling in nicely. If you missed anything, you can always go back and add the information using the timelapse analyser.
[image: ]
Go through the remaining images, then try the other image set.  A little bit of practice should get you comfortable with both the tool and the workflow.  

That’s it! If you spot any problems, or if you think of any ways that this tool should be improved, contact Saul Greenberg at saul.greenberg@ucalgary.ca .


[bookmark: _Toc294982624]Creating a Code Template
if your organization already has a stock CodeTemplate file for you to include with your image sets, then you will not need to know anything in this section.
The kinds of information and things that you and/or your organization want to track and count will be specific to the kinds of images you want to analyze and the particular data you want to get out of it.  This information will differ between organizations, and possibly between image sets and biologists.
This is where the CodeTemplate.Xml file comes in. Essentially, it is a file that is defined by you and/or your organization that specifies the kinds of information that you want to track. After you do so, you would then include that file in each image set folder. When the Timelapse tool starts, it reads that file and uses its information to:
· Create the fields that appear at the top of theTimelapse window:  the counters, the fixed choices, the notes 
· Internally store the data associate with those fields in its ImageData.Xml file
· Create the spreadsheet ImageData.CSV file, where column headers match those fields and contain the data you added to them.
CodeTemplate files are written in the Xml Extensible Markup Language . XML is a standard that specifies a set of rules for encoding documents in machine-readable form.  You don’t really have to know XML as you will be using an existing XML editor to create these rules, as described below.
Important. You should give considerable thought to the information you want to capture and how it is structured. Essentially, you are creating a standard on how the timelapse images should be analyzed and – by extension - how you want your data named and recorded, perhaps added to a database via your spreadsheet, and (eventually) analyzed via statistics. We recommend you talk with others in your organization to see what their needs are, where you (perhaps) give them samples of the codes you want to use (or a sample image set with the code template file) to see if it matches their needs.

Important. Once you analyze an image set, you should  not change the code template file in that folder. While some changes to that file won’t change things, others will break it simply because the stored data will no longer match the information specified in the code template file.  



[bookmark: _Toc294982625][image: C:\Users\saul\AppData\Local\Temp\SNAGHTMLa2f885.PNG]Downloading an XML Editor
From the Timelapse Web page, scroll to the Download Section. You will find an editor called Microsoft Xml Notepad. Select it and download it from the Microsoft web site. It will be added to your Start Menu. 
Note. If you do not have administrator permission for your computer (e.g., usually if you are using a workstation in an organization), you may need to have your systems person install this application. 
[bookmark: _Toc294982626]Downloading a CodeTemplate file
From the same web page, select and download the Sample Code template file. For this tutorial, we will be modifying this Code Template file instead of starting from scratch. Save it in some convenient place.

[bookmark: _Toc294982627]Structure of the default CodeTemplate file
Start the Xml Notepad, and use the File menu to open the CodeTemplate.xml file. You should see something like this.
[image: C:\Users\saul\AppData\Local\Temp\SNAGHTMLa7593f.PNG]



If we put this CodeTemplate file into our tutorial image set, the interface generated from it will appear as below. 
[image: C:\Users\saul\AppData\Local\Temp\SNAGHTMLd4a38c.PNG]


Information is hierarchical and is presented as an expandable tree (click the ‘+’  or ‘-‘ buttons or double-clicking the folder icon to expand or collapse one or more levels).  
The information you are interested in is contained under Codes, of which there are 8 different types. 
1. System-required codes (five of them) are those used by the Timelapse tool, where it will automatically store information associated with those codes when it first reads your images. These match the five fields displayed on the top toolbar of the Timelapse tool.  These codes are the first five listed:
· _File: image file name
· _Folder: the name of the folder containing the images
· _Date: the date the image was taken
· _Time: the time the image was taken
· _ImageQuality:  System-determined image quality: Ok, dark if mostly black, corrupted if it can't be read
Important. Do not delete these codes! If you do, the Timelapse tool will crash.  However, you can modify some of their properties. We will tell you how to do this later.
2. User-defined codes are of three types. You can define as many of each type as you want. 
· Counter: defines an entity you want to count. Counters match the counter fields in the second toolbar displayed the Timelapse tool.
· Notes: defines fields where you can enter free-form text. Notes are displayed in the third toolbar within the Timelapse tool.
· Fixed choices define a menu of choices that you can select from. Fixed choices are also displayed in the third toolbar within the Timelapse tool.
Important. The codes above appear as immediate ‘children’ under the Codes parent. When editing, adding, or deleting particular codes, you should make sure that the code remains as an immediate child. We weill tell you more about this later.
[bookmark: _Toc294982628]Structure of Codes
All codes have the same identical structure. Let’s expand the first Note (click the ‘+’ )to inspect that structure, and then see how it generates the ‘Comment 1’ field in the Timelapse tool.
[image: C:\Users\saul\AppData\Local\Temp\SNAGHTMLdd1819.PNG]
[image: C:\Users\saul\AppData\Local\Temp\SNAGHTMLdbaa02.PNG]
· DefaultValue: defines the default text to put into the field. In our example Note, it is empty, so no text is initially displayed.
· Label: defines the text displayed in the label. In our example, the label appears as  Comment 1.
· DataLabel: defines how this note appears as a column header in the spreadsheet. This is because some databases may require headings that are not particularly human readable. If left empty, the DataLabel will automatically assume the name as the Label.  In our example, if we Save and Preview to raise Excel, we see that Comment#1 is used as the column header.[image: C:\Users\saul\AppData\Local\Temp\SNAGHTMLe36a33.PNG]
· Tooltip: defines the text displayed whenever the analyst hovers over a field, or over any marker associated a Counter. This is handy to remind the analyst as to the meaning of the label.  In our example, we see that the Comment 1 tooltip matches its Tooltip description.
· Visible: defines whether the field should be displayed in the user interface, and should be set to either true or false. Invisible fields and their default values are still displayed in the spreadsheet. Reasons for having invisible items include:
· Reducing clutter on the Timelapse interface by hiding one of the fields required by the system, e.g., the Folder Name
· Reducing complexity while maintaining database consistency if, for example, a particular image set is known not to have certain entities (such as ‘boats on a lake’ in winter), or if an analyst is interested in only a subset of items
· Creating fixed data that should always be present but that the analyst does not need to see. As an example, each image may be associated with the name of the organization who owns it. To do this, a note could be labelled ‘Organization’ and its DefaultValue set to that organization’s name could be added; if it is set to invisible, it won’t appear on the interface but it will appear on the spreadsheet.
· TXBOXWIDTH: defines the width of the textbox associated with item. Since the units are somewhat arcane, you should figure this one out by trial and error. Ideally, its just wide enough to fit expected values. In our example, we see that the two notes fields labelled Comment 1 and Comment 2 have been set to different widths. 
· Copyable: defines whether that field is affected by the ‘Copy Previous Values’ button in the Timelapse tool, that is, that it will copy the data in that field from the previous image into the current image when that button is pressed. If it is true (as it is in our example), then that field appears in yellow. 
The FixedChoice code has one additional property, called List which contains a series of Item’s. The values of these items define the names of the items in the pull-down menu associated with each fixed choice. 
[image: C:\Users\saul\AppData\Local\Temp\SNAGHTMLf62d1e.PNG]
[image: C:\Users\saul\AppData\Local\Temp\SNAGHTMLf58fb5.PNG] 


[bookmark: _Toc294982629]Editing Codes
To edit a code’s value,
· Expand the node to reveal the property you want
· Single click that property to highlight the text field associated with it
· Click into the text field, and add/modify/delete text as need
[image: C:\Users\saul\AppData\Local\Temp\SNAGHTMLfb1623.PNG]
Note. While the text fields normally appear immediately to the right of each item, they sometimes get out of alignment in this editor. This isn’t really a problem, as you can still edit as required. Still, you can usually fix this by contracting and then re-expanding the Code hierarchy.
[bookmark: _Toc294982630]Adding New Codes
If you need a new code (say, a Note), the simplest way to create one is to copy an existing Note and then modify its values. For example, lets say we want to create a new Note labelled ‘Biologist’. We would do the following. 
1. Select an existing note, and copy it (either through the Edit/Copy menu or by the Copy keyboard shortcut).
2. Select the top-level Codes node and then Paste. A new note will appear at the end of the list.
3. Move the new note up the list so that it appears with the other notes in the order that you want it displayed on the screen. 
4. Open up the Note and edit its properties as above.
Important. New Codes must be positioned as immediate children under Codes. If  you create a code that appears in the wrong place, you can drag it to its correct position, or use the arrow keys in the XML Notepad’s toolbar to adjust its position.
[image: C:\Users\saul\AppData\Local\Temp\SNAGHTML10589cb.PNG]
[bookmark: _Toc294982631]Adding New Items to a Fixed Choice
The process is almost identical to Adding New Codes, except that you select the List node before pasting. Items should appear as immediate children under the List.
[bookmark: _Toc294982632]Deleting Codes and Items 
Just select a node and Cut it via the Edit/Cut menu or via its keyboard shortcut.
[bookmark: _Toc294982633]Editing System Codes
As mentioned, the first 5 codes in the CodeTemplate file are required by the system. However, as long as these codes are included, you can modify their properties. You can change everything including its Label, DataLabel, Tooltip, TXTBOXWIDTH, and Visibility. You can also add additional items to the _ImageQuality menu (but leave the existing ones there). There is no point adding a Copyable property as, it will be ignored.
[bookmark: _Toc294982634]Testing
Because this is just an XML editor that lets you do anything, you can easily modify the CodeTemplate file to a form that the Timelapse system can’t use. We suggest  that you save your original working version of the Code Template  file, and continually test any edits you make. The easiest way to do this is as follows.
1. Copy the CodeTemplate file into an example image folder containing only a few images. Make sure there is no ImageData.Xml file in that folder. 
2. Start modifying that CodeTemplate file, and save it every now and then. 
3. After each save, load up the image folder in the Timelapse tool to see if your edits have the desired effect (and to make sure you haven’t corrupted the CodeTemplate file). If it does, save a copy of the CodeTemplate file and continue.
Note. On our list of things to do is a tool that will let you add/modify / delete codes and their properties via a simpler interface. 

For now, practice with the XML Notepad. You really only need to use a few of its features, so it shouldn’t be too hard to learn.
[bookmark: _Toc294982635]You Try
Before making your own CodeTemplate.xml file, try this simple exercise using the default CodeTemplate.Xml file available on the download site.
1. Modify the first and second counter so they are called Anglers and Boats, and change the Tooltip to reflect this new name.
2. Delete the third counter.
3. Modify the first note and call it Biologist. Add your name as the Default Value and adjust its width to something that looks good on your display.
4. Modify the second note, where you just remove the Comment numbers
5. Add a new third note labelled ‘Lake Name’, again setting other properties as desired.
6. Modify the FixedChoice so that its called ‘Weather’, and edit / add items so that the menu will contain ‘Sunny’, ’Cloudy’,  ‘Raining’, ‘Foggy’ and  ‘Snowing’.
If you can do all the above, then you should have no problems creating your own custom Code Template file.
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